PT Advanced Instructor Professional Development Demo Notes and Speaker Notes

Presenter Demonstration Notes: PT Advanced

This presentation is designed for instructors who have intermediate knowledge of Packet Tracer. The
audience of participants should have basic/intermediate skills such as creating devices, configuring
devices or using Simulation Mode. The presentation details the use of Activity Wizard in designing
activities for student use.

There are speaker notes for each slide that can be helpful when discussing the concepts on that slide.
After completing the PowerPoint presentation, you should follow the steps to demonstrate the Activity
Wizard.

Activity Wizard Demo

Included in the presentation package are some files to use to demo the Activity Wizard. These files
will make your demo easy and successful.

Demo Steps

Open Packet Tracer to a blank topology.

Go to File...Activity Wizard.

Talk about the Welcome Screen and point out some of the steps.

Click on the Instructions button.

Talk about how instructors can type directly into the window, or use an HTML editor to create

more complex instructions. Tell instructors that you are going to paste in HTML code that was

created by Microsoft FrontPage and saved as a .txt file.

6. Open the files named, Instructions_pagel.txt and Instructions_page2.txt. Copy all text
(Ctrl+A then Ctrl+C) from Instructions_pagel.txt and paste into the Edit window (Ctrl+V).

7. Click the Preview as HTML tab to demonstrate that the HTML code has been rendered
properly. Read through the first set of instructions.

8. Create a second window of instructions by clicking the + button. Copy all text (Ctrl+A then
Ctrl+C) from Instructions_page2.txt and paste into the second Edit window (Ctrl+V).

9. Click the Preview as HTML tab to demonstrate that the HTML code has been rendered
properly. Read through the second set of instructions and talk about what items we would
possibly want to assess.

10. Click the Answer Network button. Point out that you will be importing a previously saved file.

11. Click the Import File to Answer Network button. Navigate to the Answer Network.pkt file
that was included with this presentation.

12. Click the Show Answer Network button to show instructors what we want students to end up
with when they finish their configuration tasks. Click the Wizard hat to return to the Activity
Wizard.

13. Talk about the Assessment Options and what we might wish to assess based on our

instructions. Point out that we gave students clear directions to configure IP addresses on all

devices.
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14.

15.

16.

17.

18.
19.

Under Assessment Items check the following list of required components:
[ Metwork
E-Housten
E-Ports
E| FastEthernetd/0
: :.V’ Access-group COut
tbl" IF Address
: ‘g Subnet Mask
E| FastEthernetd/1
{ :.yf 1P Address
i@ Subnet Mask

é--SeriaID,"l

=-15P
(- Ports
(- FastEthernet0/0
i i~g IP Address

P & Subnet Mask
E-Serial0/0

You can add feedback specific to each item to be assessed. Click once in the space to the right
of the assessment item. Type the text to use. After typing, press the Enter key.

Click on the Initial Network button. Then click on Import File to Initial Network. Navigate
to the Initial Network.pkt file included with this presentation. Talk to instructors about the
other ways you could have generated your Initial Network, such as using the Answer Network
and deleting IP addresses, etc.

Click the Show Initial Network button and point out that our devices do not have IP addresses,
masks, and no ACL has been applied on Houston router. Remind instructors of the relationship
between what’s “missing” here and what we chose to assess.

Click on the wizard hat to return to the Activity Wizard.

Discuss the Locking Options feature. Any item with a checkmark in the list of Locking Items
indicates that students are locked out of that feature. In other words, students will not be
allowed to perform the tasks with a checkmark. Force the students to configure all devices by
only using command-line interface (CLI). To accomplish this, you will lock the students out of

using the Config Tab.
ol
Activity Wizard

Welcome Building Initial Network —————— ~Exporting

Show Initial Network | Import File to Initial Network |
Variable Manager |

Copy from Answer Network

Export Initial Network to File |

Instructions
Locking Options

Answer Network Use the locking tree below to lock out certain features for this activity or leave this activity open to all
features.

Initial Net k
fitle Meiwioe Locking Items j

Password - = . Locking
#- O Interface
£+ M Topalogy
=) Global

O Create Devices

Test Activity

Save .
-0 Remove Devices

- Toggle Power

O Configure Devices

-0 Move Devices

- Use CLI Tab

Use Config Tab

0O change Interface Rl

Exit
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20. Set a password of cisco on the activity. The PT activities that are included with PT4.1 or
greater have the standard password of PT_user!.

21. Click the Test Activity button. Point out that the Instructions are what students will see to
guide them through the activity. The window can be moved, but not closed. Place a checkmark
in the checkbox located in the lower left corner to keep the instructions always on top.

22. Minimize the instructions windows and point out that it was minimized to the Task Bar.

23. Do not make any configuration changes, but click the Check Results button to see what
students will see when they finish.

24. You should see that you have 0/11 components correct and a screen similar to this one:

Activity Results Time Elapsed: 00:03:58

You did not complete the activity. Please close this window and try again.

Owverall Feedback | Ass I Connectivity Tests I
Assessment Items |Statu5 IFeedback | Completed COmponents 0
- Network .
- Houston Required Components : 11
E-Ports
EI--FastEthernethD
i M Access-group Out Incorrect
IP Address Incorrect
-M Subnet Mask Incorrect
[l-FastEthernet0/1 Component Types:
i =X IP Address Incorrect
{ =M Subnet Mask Incorrect P . 0/10
E-Serialof1
M IP Address Incorrect Routing 1 0/0
“¥ Subnet Mask Incorrect
E-1SP
E-Ports ACL 1 0f1
El-FastEthernetd/0
: X IP Address Incorrect NAT : 0/0
; M Subnet Mask Incorrect
- Serialo/0 Physical . 0/0
-3 IP Address Incorrect
M Subnet Mask Incorrect Switching ' 0/0

Others : 0/0

Close |

25. Demonstrate editing an existing .pka file by opening the file named *“Activity Wizard
Sample.pka” that was included with this presentation.

26. When the file is open, use the File...Activity Wizard menu to access the edit screens. When
prompted for the password, enter “cisco”.

27. Show that any of the elements can be edited.

Presenter Demonstration Notes: PT Advanced
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Topic, Audience, Goal/Purpose of this PowerPoint presentation:
This presentation is designed for instructors who have intermediate
knowledge of Packet Tracer. The audience of participants should have
basic/intermediate skills such as creating devices, configuring devices
and using Simulation Mode. The presentation details the use of Activity
Wizard in designing activities for student use.

There are speaker notes for each slide that can be helpful when
discussing the concepts on that slide. After completing the PowerPoint
presentation, you should follow the steps to demonstrate the Activity
Wizard.

1. Who is the intended audience?
Academy instructors; primarily related to CCNA content
Academy instructors who already have basic and intermediate skills
using Packet Tracer.
Basic skills include:
» Create & arrange devices
» Create connections
» Configure devices
* Add notes
» Use PC desktop applications
» Create a simple simulation
Intermediate skills include:
* Using Simulation Mode
» Creating scenarios
* Examining PDU information
» Using the Challenge Mode
If you don’t already know these skills, you should start with the
Novice session and/or the Intermediate session.

2. What is the intended learning environment for using this PPT?
Remote; 60 minute session using WebEx and the WebEX Internet
Phone feature. You may use another web conferencing tool along
with a conference call or a phone bridge. Also, these materials may
be easily modified for use in an in-person environment.

3. What is the goal/purpose of these materials?
For academy instructors and those interested in learning to use Packet
Tracer 4.1 or greater Activity Wizard to design and create Packet
Tracer activities. The purpose of this demonstration is to provide
instructors with specific examples of how to teach using these
features of Packet Tracer. By using specific examples, instructors will
be able to see how they can add Packet Tracer to their classroom
toolkit.
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4. Prior to web conference session
Send the ppt file to participants prior to the training session. Have participants print
out the ppt as a handout in advance. Demonstrate PT over WebEx while
participants follow along with their handout. Participants may then make notes on
the handout during the session - or - If the participant has the available computers,
they could have one logged into the WebEXx session and the other they could use to
practice using PT4.1.

NOTE: This PPT and Speaker Notes were created by updating the “PT Advanced” PPT and
Presenter Notes. The updates are based on PT5.0 (RC1) on July 15, 2008.

alialn
cIsco

Facket Tracen

Advangedisessian

Title Slide

Gisco| Networking Academy”

Cisco Networking Academy Program

Packet Tracer: Advanced Session

Welcome. This 60-minute session will not allow much opportunity
for you to speak so during the session please feel free to type
guestions in the WebEx chat window.

Thank you for participating in this session of Packet Tracer. To
get an idea of the experience-level of this group, | would like to
ask you a few questions and ask you to use the “yes” and “no”
indicators to respond. If you look in the right-hand side of the
WebEx window, you should see the yes and no buttons. Click on
the yes button to demonstrate that you have found it. Thank you.
* Have you seen or tried PT before?
» Have you used any version of PT before in your teaching?
* Did you participate in the Packet Tracer Novice session?
» Did you participate in the Packet Tracer Intermediate
session?
The focus of this presentation is on using the Activity Wizard to
design Packet Tracer activities. It is important that instructors
have basic and intermediate skills in order to fully understand the
tasks in this presentation.
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PT Advanced Session
= PT Features.

= The Activity Wizard is an assessment tool that allows
you to create highly specific networking scenarios for
other users.

= This tool is particularly useful for instructors creating
activities for students to complete.

= When students start an activity, they are presented with
an initial network and a set of instructions. Students
follow the instructions to complete the activity, then they
can check their finished network.

= Instructors have control over many aspects of the
activity.

Slide 2

Slide 2 — PT Advanced Session
Academy instructors who already have basic and intermediate
skills using Packet Tracer.
Basic skills include:

» Create & arrange devices
Create connections
Configure devices
Add notes
Use PC desktop applications

» Create a simple simulation
Intermediate skills include:

* Using Simulation Mode

» Creating scenarios

e Examining PDU information

» Using the Challenge Mode
If you do not already know these skills, you should start with the
Novice session and/or the Intermediate session.
This presentation will cover the Activity Wizard, an assessment
tool that allows you to create highly specific networking scenarios
for other users. This tool is particularly useful for instructors
creating activities for students to complete. When students start
an activity, they are presented with an initial network and a set of
instructions. Students follow the instructions to complete the
activity, and then they can check their finished network.
Instructors have control over many aspects of the activity.

BT Featlnes

S"i'i'de 3

Slide 3 — PT Features
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Slide 4 - Features ( PT4.1 or greater)
If you have used a previous version of Packet Tracer, then you
will be very interested in learning about some of the new features
included in PT4.1 or greater.
Zoom viewing tools have been added.

e Zoomln (Ctrl+l) to zoom into the workspace.

» ZoomOut (Ctrl+U) to zoom out of the workspace.

e ZoomReset (Ctrl+T) to reset the zoom of the workspace.
Editing tools

* Copy (Ctrl+C) to copy the selected item.

» Paste (Ctrl+V) to paste the selected item.

» Undo (Ctrl+2Z) to undo the previous action.
The drawing Palette tool (Ctrl+D) and Device Template
Manager
A Cluster function

» Cluster function will group devices into a cloud.
A Move function

» Move will take a device and move it into or out of a cloud.

Slide 5

Slide 5 — Other GUI Improvements
* Another GUI improvement is the ability to create a copy of a
device by performing a <CtrI><drag> copy on single or groups
of objects. For this example, assume you want a copy of the
1841 router.
0. Place the mouse pointer on Router0.
0. Hold the Control key down.
0. Click and drag the duplicate router off to the side.
0. Click on the duplicate router name to edit
» Using the Place Note tool, you can write and place sticky
notes anywhere in the workspace. Now in PT4.1 and greater,
you can select several notes as a group and then copy and
paste them.

I 18

Legacy Devices (PT 4.1)
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Slide 6

Slide 6 — Legacy Devices (PT4.1)
* New router models: 1841, 2811, Generic empty router
* New switch models: 2960, Generic empty switch
* New wireless device: Linksys WRT300N
* New end device: 7960 IP Phone
* New WAN emulation devices: Empty cloud, DSL modem,
Cable modem
* New category of Custom Made Devices
» The Custom Made Devices are devices with some pre-
configuration and some added interfaces. As you can
see the PC1 must have a wireless NIC since the
Linksys Wireless Router and PC1 have found each
other.
* New connection type: Coaxial cable
* The server has evolved from being another icon for a host to
actually having some server functionality. The four services
available are WWW, DHCP, TFTP, and DNS.
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*The new 3560
switch allows for e

layer 3 routing WiF

*The Multiuser
connection (Peer0
in the picture) can
connect by TCP/IP e
to a Multiuser T
connection of
another PT

Slide 7

Slide 7 — New Devices in PT5.0

The new 3560 switch allows for layer 3 routing

The Multiuser connection (Peer0 in the picture) can connect by
TCP/IP to a Multiuser connection of another PT

@ 2 LLT, R

Slide 8

Slide 8 — Device Template Manager

The Device Template Manager was added to PT4.1 or greater in

response to a number of requests from instructors to be able to

create pre-configured devices. The Device Template Manager
allows you to save devices as templates and create devices from
the saved templates.

1. To create a custom device template, first place a device on the

workspace. Then add modules, if desired, and/or configure, if

desired.

Click on the Custom Devices Dialog button.

Click on the Select button.

The Device Template Manager window will close. Now click

on the device to make into a template.

5. The Device Template Manager window will reappear. Edit the
name and add a description. Click the Add button.

6. PT4.1 will prompt you to save your device template.

* To add a custom device on the Logical Workspace, click on
the Custom Made Devices icon in the Device-Type
Selection Box to display the custom devices in the Device-
Specific Selection Box. Here you will find all of the device
templates that have been created. You can then add the
custom devices to the Logical Workspace as you would with
other devices.

* To remove a custom device on the Logical Workspace, click
on the Custom Devices Dialog on the Main Tool Bar to open
the Device Template Manager. Under the Edit section, select
the device template that you want to remove in the drop down
menu and then click on the Remove button. The device
template file that was saved in the 'templates’ directory will be
removed as well.

hwn
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Slide 9 — Port Label Options and Other Options

Alternately, you can choose to have Port Labels Always
Shown from the Options menu.

Two features in PT4.1 or greater that were added based on
instructor requests are the Show Link Lights option and the
Hide Device Label option. Use these options to show or hide
the device link lights and the device labels.

.....

Slide 10

Slide 10 — Clustering Devices

New to PT4.1 or greater is the feature of clustering devices to
simplify the appearance of the Logical Workspace. Clustering
reduces a group of devices and connections into a single
image.

By default, devices are created in the Root level, which is
indicated on the Logical/Physical Workspace Bar. In this slide,
you see a small network of 4 PCs and a switch and this
network is located at the Root level in the Logical Workspace.
To cluster this small network, select the devices on the
workspace and then click on the New Cluster button.

To drill down into the cluster, simply click on the cluster. Notice
in the navigational bar ClusterO is listed.

To move back to the Root level, click on Root in the
navigational bar.

To rename the cluster, click on its label to enable the label
textbox.

To uncluster a group of devices, highlight the cluster and then
delete it with the Delete tool.
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Slide 11

Slide 11 — Connect to a Device Within a Cluster

You can make a connection from a device outside of a cluster
to a device within a cluster. In this example, the router is
connected to the switch within the cluster using a copper
straight-through cable.

Select the connection type of a copper straight-through cable.
Click on the router and select one of the FastEthernet
interfaces.

Then click on the cluster. From the menu, select SwitchO and
then select one of the FastEthernet interfaces on the switch.
Let's say you have decided that the router should have been
created within the cluster instead of outside of the cluster. You
can move the router into the cluster using the Move Object
button.

Click on the Move Object button

Also, when you can create a cluster, you can move objects
and devices within the cluster hierarchy with the Move Object
button. To do so, click on the Move Object button and then
select an object or device. This opens a menu showing the
cluster hierarchy. You can then select the location to which the
object should be moved.

Slide 12 — Multiple Device Windows

PT4.1 or greater supports multiple device windows open
simultaneously. Notice in this slide there are two device
windows open and visible simultaneously and they are
independent of the main PT frame. Pop-up windows are now
treated as independent windows so you can place them
anywhere on the desktop. You can maximize and minimize
windows by clicking the buttons in the Task Bar or by using
the <Alt><Tab> key combination. You can have as many
windows open as you need.

el vl ? 4 ..»;[W

Where is the Activity Instructions Window?

Slide

; =

Slide 13 — Where is the Activity Instructions Window?

Due to the added feature of independent windows in PT, you
may lose track of various windows. Remember you can
maximize and minimize windows by clicking the buttons in the
Task Bar or by using the <Alt><Tab> key combination.

In this slide, you see a screenshot of a Packet Tracer Activity
launched from CCNA 1 Exploration 4.0. In a PT4.1 or greater
Activity (a .pka file), it is not possible to close the Activity
Instructions window. When you click on the Close button of the
Activity Instructions window, the window is minimized in the
Task Bar.

To maximize the window again, click on the PT Activity button
in the Task Bar.
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Slide 14 — Look at an Activity
First, we will look at an activity from the perspective of a student.

\Laar &t an
Activity

Slide 14

Slide 15 — A Packet Tracer Activity

The Packet Tracer Activity Wizard is an assessment tool that

enables an instructor to create detailed networking scenarios for

students to complete. A Packet Tracer activity file has the .pka

extension.

A PT activity can include the following elements:

il ~~ |+ Aninitial network or starting topology to begin with in

Slide 1 completir)g the a_ctivity _ _ N

* Detailed instructions to follow in completing the activity

* Automatic scoring and feedback by clicking Check Results
button and viewing the Percentage Complete indicator. Every
3 seconds the progress of completion is re-evaluated and the
indicator is updated.

» Atimer to measure elapsed time or a countdown clock

A Packet Tracer Activity
t-’r':'.'.-r'l‘."w!h. = =
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Activity Results

O ORI
iy
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Slide 16 — Activity Results

The Packet Tracer Activity Wizard is an assessment tool that
enables an instructor to create detailed networking scenarios for
students to complete. A Packet Tracer activity file has the .pka
extension.

Other features in PT Activity Wizard include:

Automatic scoring and feedback by clicking Check Results
button and viewing the Percentage Complete indicator. An
answer network is used to compare the student’s effort to
assess their work.

Click the Check Results button to view the Activity Results
windows.

The Overall Feedback tab displays the general feedback on
completeness of the activity.

The Assessment Items tab displays feedback and status per
assessment item. The current score is also displayed.
Incorrect items display feedback specific to that item. Correct
items will not display that feedback detail.

The Connectivity Tests tab displays which PDUs will be
evaluated as correct or incorrect based on whether the PDU
should be successful or fail.

Password protection to maintain the security of the answer
network

Use of variables to create different activities out of one activity
file

Slide 16
Slide 17 — Activity Wizard
This PowerPoint presentation will be followed with a
demonstration of the PT Activity Wizard.
Agtyity Wizt

Slide 17
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PT Activity Wizard Vocabulary

= Answer network: The network that you want students
to end up with after they perform whatever
configuration tasks they are instructed to complete. The
“correct” answer.

= Initial network: The network that you give students to
begin with in completing the activity. This can be as
“complete” or incomplete as you like. Just remember
that you need to give clear instructions so that students
know what Answer network you are expecting.

Slide 18 — PT Activity Wizard Vocabulary

Answer network: The network that you want students to end up
with after they perform the configuration tasks they are instructed
to complete. You might want to think of the Answer network as
the “correct” answer.

Initial network: The network that you give students to begin with
in completing the activity. This network can be as complete or
incomplete as you want. Just remember that you need to give

Slide 18 clear instructions so that students know what “answer” you are
expecting.
Slide 19 — What can | assess?
What can | assess? * An assessment item is a feature in the student configuration
i that must match that feature's configuration in the answer
i i network.
ZiZCZ”;"‘“ = . * You choose the assessment options by checking items in the
«haT expandable tree.
_ * You can check specific features or entire categories. For
ST ORI e K example, you can check just the IP address of a port of a
Slide 19 particular router, or click on the Ports category to check all

settings of all ports on the router.
» Assessment categories are
» |IP (for example, IP addresses on interfaces)
* Physical (for example, bandwidth, power, and duplex

settings)

* Routing (for example, static routes and routing
protocols)

* Switching (for example, VLANS)

« ACLs

 NAT

* The Answer network used in creating the activity will dictate
which items may be assessed. If the Answer network contains
a router configured with an ACL, then the student could be
assessed on creating that ACL. If the Answer network does
not have the ACL configured then the student cannot be
assessed on creating that ACL.

* Inthe Assessment Items, only the items marked with a green
dot can be assigned a variable.
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Planning: Create the Answer first...

= Using the Activity Wizard is easier with a [ittle up front
planning.

= The easiest way to create activiias using the wizard is
to create the Angwer netwiork first

= By ramoving or ediling elements of the answier natwork,
the Inital network is created.

Or..

= |mport & pki file that already contains all or most of the
elements you might want 1o assess . This imported file
becomes the Answer network

Slide 20

Slide 20 — Planning: Create the Answer first...

* Creating the answer network first allows you to construct a
working network with all of the elements that you would like to
assess.

* The answer network can be as complex or as simple as
needed for the purpose of the activity.

* The answer network is edited to remove any of the elements
that you wish for students to complete.

* Forinstance, if the goal of the activity is to test a student’s
ability to apply an IP address to an interface and bring it up to
operational status, the Answer network would have the
interface configured and working. Then the IP address would
be removed and the interface would be shut down to create
the initial network.

Activity Wizard

I

s J

Slide 21 — Activity Wizard
» Create or open the .pkt file that you want to use as the Answer
network. You should thoroughly test this network to ensure

. o P that it has all of the elements that you wish to assess, and that
| R those elements are operational.
/,L\ * Note: The examples used in this presentation are based on
£a) 4 using the Answer Network.pkt file provided with this
o= Panwames b PowerPoint file.
Slide 21 * Then open the. Activity Wizard. .

* The Activity Wizard can be accessed from the File menu or by
clicking on the Activity Wizard button on the tool bar. It can
also be opened by typing CTRL+W.

Answer Network Slide 22 — Answer Network
P — * We will use this topology as the answer network, so we
s | answer Yes.
e * If you wanted to import another file to use as the answer
;L — network, you would answer No here and import a file when

oy [I7th= op=n fopologywil ba T1e answer
W B W | retwore cliseves

s

Slide 22

prompted to do so in a later step.
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Welcome Screen

Activity Wizard

[The welcome screen
briefly descrbes the steps
| for makng your activty.

Slide 23

Slide 23 — Welcome Screen

The Welcome screen lists the basic steps you will need to create
your activity.

You can see that the steps to create the activity are:

1. Create (or import) the answer network, and set the
assessment items.

2. Create (or import) the initial network, which will be the
user’s starting point. A blank initial network may also be
used. Note: For accurate scoring, device display names in
the initial network must match the display names in the
answer network.

3. Put constraints on the user’s ability to use certain features
during the activity.

4. Write a clear set of instructions for the activity. (This step is
one of the most important steps to ensure accurate
scoring.)

5. Password-protect the activity to prevent unauthorized
changes to activity parameters.

6. Save the activity. Activity files are .pka files.

The following slides will provide more detail for each of these
steps.

Instructions

Slide 24

Slide 24 — Instructions

You can complete the tasks along the left side in the order that

works best for you. The third button is Instructions.

* From the Instructions tab, you can add detailed instructions
describing what must be done to complete the activity
successfully.

» HTML tags such as <b> for bold, <i> for italics, or <u> for
underline may also be used when typing in the instructions
field. For a full list of supported HTML tags, please go to the
QStyleSheet Class Reference page at
http://doc.trolltech.com/3.3/gstylesheet.html.

1. Type in the text or paste in copied text.

2. Edit the text to include HTML tags, if desired.

3. Click on the Preview as HTML tab to see how the
instructions will appear to the students.

4. Click on the Edit tab if more changes are needed.

* Remember that clear instructions will ensure that students
understand the task and will make scoring more accurate. You
do not want students to get items incorrect due to poorly
written instructions.

New to PT4.1 or greater is the option to have multiple pages of

instructions.

* Use the + button to add more pages to the instructions.

» Use the x button to delete a page of instructions.

* Use the < and > to move through the pages.



http://doc.trolltech.com/3.3/qstylesheet.html
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Instructions in HTML

Activity Wizard

Slide 25

Slide 25 — Instructions in HTML

* You can use many basic HTML tags or copy HTML code in
from an outside HTML editor.

» Copying code from an HTML editor works well! The above
example was generated by Microsoft FrontPage.
Note: The text used in this example is contained in the
Instructions.txt file provided with this PowerPoint file.

* There are free HTML editors available on the web.

Previewing the HTML

Activity Wizard

Click Preview as HTML
| o verify your coding

Slide 26

Slide 26 — Previewing the HTML

* Click Preview as HTML to verify your coding.

» If the instructions need edits, remember to go back to your
HTML editor to make the changes and then paste the code
into the Edit screen.

Answer Network

Activity Wizard

Slide 27

Slide 27 — Answer Network

The Answer Network tab allows you to customize the activity’s

answer network, assessment options, timer settings, connectivity

testing, and feedback options.

* You can see the answer network at any time by clicking on the
Show Answer Network button. The answer network can then
be modified, if necessary.

* You can also import a different answer network from an
existing .pkt file or you can export the current answer network
to a .pkt file.
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Slide 28 — Assessment Options and Items

Assessment Options and ltems » By default all available Assessment Options will be displayed

——— but will be unchecked. This means that no items under those

— : ‘ categories will be assessed unless you make changes within

= — the Assessment Items tree.

= * For instance, in order to assess the ACL “HFW1” on router
Houston, we must navigate the Assessment Items tree and
check that ACL in the list.

» This is a good example of the value of clear instructions.
Packet Tracer will now assess whether or not a student
creates an ACL named “HFW1” on the router Houston. If the
instructions are not clear about the name of the ACL, a
student would get this “wrong” even if the ACL was correct.

* You can add feedback specific to each item to be assessed.
Click once in the space to the right of the assessment item.
Type the text to use. After typing, press the Enter key.

Slide 28




PT Advanced Instructor Professional Development Demo Notes and Speaker Notes

...............

slide 29

Slide 29 — Assessment Option Tips

1. Notice the assessment item of Enable Secret. When an
encrypted password is saved and the file is reloaded, the
encrypted password will not match the password that was
configured in the enable secret command. Avoid selecting Enable
Secret for assessment purposes. The student will never be able
to get it correct.

2. If you want to assess a student’s ability to configure vty login,
then under VTY Line 0 only select Login and Password. That
should be sufficient to assess the vty login configuration. Keep in
mind that the student will see the assessment items tree under
the Assessment Tabs in the Activity Results window. If each of
the vty lines (0 — 4) are assessed then they will all be included in
the assessment items tree.

3. The Power assessment item under an interface assesses
whether or not the student issued the “No Shutdown” command
on the interface or whether or not the student turned a port on
under the Config Tab. Notice that the terminology is different.

4. When assessing the student’s ability to configure an IP address
you will most likely want to also assess their ability to configure
the appropriate subnet mask. This is especially true when the
subnet mask is not the default subnet mask.

5. Be careful. If you place a checkmark next to a device, you have
selected that all elements are to be graded. This is probably not
what you are trying to assess and will result in a very long
assessment item tree.

6. When you are assessing a student’s ability to make a specific
device connection, consider assessing both the link port and the
type of cable connection.

7. When assessing a student’s ability to configure serial
connections including clock rate, then make sure DCE interfaces
and clockrates are specified in the instructions, and select the
port’s clock rate is to be graded in the Assessment Items list.

8. Grading both ends of a link is redundant, since the cable type
can only be the same on each end. If on router A Fa0/0 | say
connect to Switch B, Fa0/23, testing either end will assess
properly whether the connection has been made.

9. Device and display names in the initial and answer networks
must be the same, or the user must be told explicitly how they
should configure them, otherwise all grading related to that device
will grade incorrectly.

10. If you are going to grade a string variable, such as a display
name, hostname, banner, or description, make sure the
instructions are explicit. Otherwise the student cannot get that
component correct.

11. If you want students to configure the console password,
grade both the login parameter and the password.
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Activity Timer Slide 30 — Activity Timer
== |+ Under Timing tab, you can have PT track how much time has
= e e elapsed since the activity was started or make this a timed
= mmen activity.

meeemmwass || ® YOU can use Countdown to give students a limited amount of
time to complete the activity.

* You can also simply turn the timer off by choosing None.

* The default is Time Elapsed.

Slide 30

Connectivity Test | Slide 31 — Connectivity Test

_ Ay s | The connectivity tests are based on the first scenario (Scenario0's

=== | PDU list) of the answer network’s User Created PDU list. There

| are three test conditions to choose from: "Do Not Test”

"Successful”, or "Fail”.

» Ifthe PDU is supposed to succeed after all tasks are
completed properly then the Test Condition should be marked
as Successful.

» Ifthe PDU is supposed to fail after all tasks are completed
properly then the Test Condition should be marked as Fail.

» If the success or failure of the PDU should not be evaluated,
then the Test Condition should be marked as Do Not Test.

Slide 31

Slide 32 — Initial Network
The Initial Network tab allows you to set up the initial network
and lock certain options within PT.
* The Show Initial Network button will display an empty
topology.
* Use the Copy from Answer Network button to copy the
answer network to the initial network.
) » Then click on Show Initial Network button and adjust the
Sli initial network so that the assessed items are removed.
ide 32 . o
* You can also import and export the initial network.
For this example, only remove the IP addressing and the routing
information. Do NOT remove the WICs from the routers.

Initial Network

Copy from Answer Network Sllde 33 - COpy from AnSWGI' Network
Replacing the initial network with the answer network cannot be
— undone.

Slide 33
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Show Initial Network

Activity Wizard

[ After copying the Answer rmandsuat
ST Network 35 the Inilial Metwork,
select Shove Initial Network (o

iterns you v
g g For instance, you migt
rermove the interface I
I addresses if that is one
I vou wish to assess.
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Slide 34 — Show Initial Network

If you choose Copy from Answer Network and you then
select Show Initial Network you should see your Answer
network in PT.

You will need to edit the network to remove all elements you
will be assessing. Remember to click the Activity Wizard hat in
the lower left hand corner when you are finished editing.

Set Locking Options

Activity Wizard

Under Locking Options, you tan
SRSl vhlch Tallres are not
cessitl

accessible wilhin the actiy
Checkiterns you want lncked
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Slide 35 — Set Locking Options

Under Locking Options, you can specify which features are
not accessible within the activity. For example, you can
prevent devices from being deleted or disconnected. You can
force students to only use the CLI Tab to configure devices.

Password Options

i
Activity Wizard

| Click Enable P

/’ the passwiond is sal

vord to ensure

he lackicon will ek if e
pagsword is enabled

Click Test Actiity to make sure the

actvity performs as infended.
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Slide 36 — Password Options

The Password button allows you to set a password on this
activity so that it cannot be changed. Notice the lock icon is
unlocked when there is no password set.

Click Enable Password to ensure the password is set.

The lock icon will lock if the password is enabled.

The Test Activity button allows you to test the activity without
having to exit the Activity Wizard.

Testing the Activity
i s Lo

The Test Activity
wizard eap
remings you I

= e | The Instructions window cannot be closed.
% 1 1 o o ¢ | You can mirimize the windw of resize
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Slide 37 — Testing the Activity

The Test Activity wizard cap reminds you that you are testing
the activity. Click on it to exit testing.

Note that the description window cannot be closed. You can
minimize the window or resize it so that only the title, Check
Results, and Reset Activity buttons are showing.
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Use fre Check Res
butten atartime to g2 how
many of Ihe assessed ileme
have been completed sofar

U= the Resel Actily
ouon to restar the actiy

=
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Slide 38 — Check Results

» Use the Check Results button at anytime to see how many of
the assessed items have been completed so far.
» Use the Reset Activity button to restart the activity.

Activity Results

Activity Results Time Lete, 00113123
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Slide 39 — Activity Results

When the student clicks Check Results, she can see exactly
which assessment items have not yet been completed or were

answered incorrectly.

Saving the Activity

e —
Activity Wizard

Tihen satefied wilh the actity, cick e Sawe Bufion. S=ve
the file th an s propriate rame in the drectory of your
choies. Nole thal the fie exdension or acihilles is pka
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Slide 40 — Saving the Activity

» The “Save” button allows you to save the activity as a special

.pka file.

Editing a .pka

nem® = [ S S

Slide 41 — Editing a .pka

* An existing activity file (.pka) can be edited if you know the
password or if there was no password configured on the

activity.
* Open the .pka.

* Move the instructions out of the way if necessary and use the

File...Activity Wizard menu.

» If prompted for the password, enter it in the dialog box.
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Slide 42

Slide 42 -Q and A

Cisco | Networking Academy”

| Mind Wide Open

Slide 43

After completing the PowerPoint presentation, refer to the
PT50_Advanced_Demo Notes.doc and follow the steps in this document
to demonstrate the use of Activity Wizard.
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